
Instructions for Evaluator

Name of Evaluator: Project Name:

Date of Evaluation: Learning Developer:

Team Leader: Project Manager:

After you have spent time using the material to be evaluated, complete the following tables. Decide which 
sections are relevant to the material. (The General section will be relevant to all projects.) Then check the 
boxes next to the guidelines that are met in the material. For each guideline that is not met, enter notes 
that will help the Learning Developer to fix the issue. Include specific locations of issues where possible.

Accessability Standards Checklist
Southwest Airlines University LD&D



All meaningful images have alternative 
text provided in the settings. 
 
WCAG 2.1 – 1.1.1

Images are set as “In line with text” in 
text wrapping, rather than tight, square, 
in front, or behind alignment. 
WCAG 2.1 – 2.4.3

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Decorative images do not have 
alternative text (screen readers will not 
perceive them). 
 
WCAG 2.1 – 1.1.1

Graphics such as graphs, illustrations, 
charts, and images have alternative text 
(“alt text”) for the content and/or function 
of the graphic. 
WCAG 2.1 – 1.1

If text has a background image, the text 
still meets color contrast guidelines. 
WCAG 2.1 – 1.4.6

Alt Text

Graphics 

All webpages, documents, presentations, 
and courses have the native language 
selected for screen reader access. 
WCAG 2.1 – 3.1.2

Text can be resized without assistive 
technology up to 200% without loss of 
content or functionality. 
WCAG 2.1 – 1.4.4

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

There is no content that flashes or 
flickers more often than three times per 
second. 
WCAG 2.1 – 2.3.1

Content does not restrict view and 
operation to a single display orientation, 
such as portrait or landscape (unless that 
orientation is essential to the context). 
WCAG 2.1 – 1.3.4

A mechanism for identifying the 
expanded form or meaning of 
abbreviations is available. 
WCAG 2.1 – 3.1.4

Textboxes can be perceived by assistive 
technology and in a logical reading 
order. 
WCAG 2.1 – 1.3.2

Lists are displayed with bulleted or 
numbered list style. 
WCAG 2.1 – 1.3.1

Content

Section 1: General
This section is not applicable NOTE: There are two pages for the 

General section. Select the tabs to 
navigate each page. 

https://www.w3.org/TR/WCAG21/#non-text-content
https://www.w3.org/TR/WCAG21/#focus-order
https://www.w3.org/TR/WCAG21/#non-text-content
https://www.w3.org/TR/WCAG21/#text-alternatives
https://www.w3.org/TR/WCAG21/#contrast-enhanced
https://www.w3.org/TR/WCAG21/#language-of-parts
https://www.w3.org/TR/WCAG21/#resize-text
https://www.w3.org/TR/WCAG21/#three-flashes-or-below-threshold
https://www.w3.org/TR/WCAG21/#orientation
https://www.w3.org/TR/WCAG21/#abbreviations
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/TR/WCAG21/#info-and-relationships


Avoid using words that apply to only to 
sighted users, such as “click” and “look 
at.” Instead use “activate” or “select” 
instead of “click” and “examine” instead 
of “look at.” 
WCAG 2.1 – 3.1

Link text describes the target of the link. 
 
WCAG 2.1 – 2.4.4

Links are indicated with color and at least 
one other indicator, such as underlining, 
context, or location in a navigation 
menu. 
WCAG 2.1 – 1.4.1 

Content is presented in a logical 
sequence, both visually and when 
perceived by assistive technology. 
 
WCAG 2.1 – 1.3.2

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Reading Order

Use a caption and summary when 
displaying data tables. The summary 
should reflect what a sighted user could 
glean from a table at a quick glance. It 
should be typed into the alternative text 
description field. 
Section 508 – 302.9

Tables use row and/or column headings. 
WCAG 2.1 – 1.3.1

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Tables are read in the correct order by 
assistive technology. (right to left, top to 
bottom) 
WCAG 2.1 – 1.3.2

If a table spans multiple pages, the 
header row is set to repeat at the top of 
each page. 
 
WCAG 2.1 – 1.3.1

If a table contains merged cells, the table 
still reads in the correct order. (right to 
left, top to bottom) 
WCAG 2.1 – 1.3.2

TablesInclusive Language

Links

Color is not the only way of providing 
information. Color can be used in 
conjunction with a secondary code such 
as text or a symbol. 
WCAG 2.1 – 1.4.1

Notes and Locations of Issues

Notes and Locations of Issues

Large text (18 pt. or 14 pt. bold): color 
contrast ratio of 3:1  
Small text (Smaller than 18 pt.): color 
contrast ratio of 4.5:1 
WCAG 2.1 – 1.4.3

Color Contrast

NOTE: There are two pages for the 
General section. Select the tabs to 
navigate each page. 

Section 1: General
This section is not applicable

https://www.w3.org/TR/WCAG21/#readable
https://www.w3.org/TR/WCAG21/#link-purpose-in-context
https://www.w3.org/TR/WCAG21/#use-of-color
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.access-board.gov/ict/#302.9
https://www.w3.org/TR/WCAG21/#info-and-relationships
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/TR/WCAG21/#info-and-relationships
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/TR/WCAG21/#use-of-color
https://www.w3.org/TR/WCAG21/#contrast-minimum


All pages or frames have a title (<title>)
that describes the topic or purpose of 
the page. This allows screen reader users 
to navigate multiple open pages at once 
without having to read the page content. 
WCAG 2.1 – 1.3.6 Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

All functions are available using only 
a keyboard and can be perceived by 
assistive technology (such as JAWS and 
ZoomText). 
WCAG 2.1 – 2.1

When the keyboard is used to move to 
a page location, the keyboard can also 
be used to move away from it. (It does 
not trap the keyboard-only user on that 
object.) 
WCAG 2.1 – 2.1.2

Assistive Technology
When using a keyboard to navigate a 
page, the focus indicator preserves the 
meaning of the page with a logical order. 
 
WCAG 2.1 – 2.4.3

If content, such as a menu, is repeated 
on multiple pages, there is a link to skip 
that content. 
 
WCAG 2.1 – 2.4.1

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

The focus indicator adheres to color 
contrast guidelines. 
 
WCAG 2.1 – 1.4.3

Focus Indicator

Skip to Content

Section 2: Websites
This section is not applicable

https://www.w3.org/TR/WCAG21/#identify-purpose
https://www.w3.org/TR/WCAG21/#keyboard-accessible
https://www.w3.org/TR/WCAG21/#no-keyboard-trap
https://www.w3.org/TR/WCAG21/#focus-order
https://www.w3.org/TR/WCAG21/#bypass-blocks
https://www.w3.org/TR/WCAG21/#contrast-minimum


Document has been created using 
“Styles” which indicate nested heading 
levels. (Heading 1, Heading 2, etc.) 
 
WCAG 2.1 – 2.4.10

Notes and Locations of Issues

Notes and Locations of Issues

Heading levels are not skipped (i.e. If 
there is a Heading 3, it must be nested 
under Heading 2.) 
 
WCAG 2.1 – 2.4.10

Headings

Avoid manually created white space 
through use of the Enter key. Use 
paragraph formatting to create space. 
 
WCAG 2.1 Supplemental

Notes and Locations of Issues

White Space

Section 3: Word Processing Documents
This section is not applicable

https://www.w3.org/TR/WCAG21/#section-headings
https://www.w3.org/TR/WCAG21/#section-headings
https://www.w3.org/WAI/WCAG2/supplemental/patterns/o3p10-whitespace/#moredetails


The notes pane is used to describe 
complex images, charts, tables, and 
audio. 
 
WCAG 2.1 – 1.1

Slide reading order is logical. (Ensure 
that reading order is top to bottom in 
the Selection Pane by locating Home 
tab>Arrange>Selection Pane). 
 
WCAG 2.1 – 1.3.2

Notes and Locations of Issues

Notes and Locations of Issues

Notes Pane

Reading Order

Each slide has a descriptive and unique 
title. A slide deck that has multiple slides 
with the same name makes it difficult for 
screen reader users to differentiate slide 
content. 
 
WCAG 2.1 – 2.4.2

Notes and Locations of Issues

Slides Titles

Section 4: PowerPoint Presentations
This section is not applicable

https://www.w3.org/TR/WCAG21/#text-alternatives
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/TR/WCAG21/#page-titled


Each worksheet begins in cell A-1 with 
navigation instructions for the sheet. 
 
WCAG 2.1 – 2.4

If there are multiple tables, graphs, or 
charts on a worksheet, they are able to 
be read by assistive technology (such 
JAWS) in a logical reading order. 
 
WCAG 2.1 – 1.3.2

Notes and Locations of Issues

Notes and Locations of Issues

Instructions

Reading Order

White space is controlled with row and 
column sizing, or with not more than one 
blank row or column. 
 
WCAG 2.1 Supplemental

Notes and Locations of Issues

White Space

Section 5: Spreadsheets
This section is not applicable

https://www.w3.org/TR/WCAG21/#navigable
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/WAI/WCAG2/supplemental/patterns/o3p10-whitespace/#moredetails


Document is set to “Enable 
assistive technology support” 
(Edit>Preferences>Accessibility>Other 
Accessibility Options) 
WCAG 2.1 – 4.1

Document has been designed using 
appropriate tags which can be seen in 
the tag tree. 
WCAG 2.1 – 1.3.2

Ensure language is set in 
the document preferences. 
(Edit>Preferences>Language) 
WCGA 2.1 – 3.1.1

Notes and Locations of Issues Notes and Locations of Issues

Notes and Locations of Issues

Assistive Technology Tags

Language

Reading/tab order is logical. (left to right, 
top to bottom) Use the Reading Order 
Tool to edit or add tags. 
WCAG 2.1 – 1.3.2

Document is set to “Use document 
structure for tab order when no 
explicit tab order is specified” 
(Edit>Preferences>Accessibility>Other 
Accessibility Options) 
WCAG 2.1 – 1.3.2

Notes and Locations of Issues

Notes and Locations of Issues

Reading Order

Section 6: PDFs
This section is not applicable

https://www.w3.org/TR/WCAG21/#compatible
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/TR/WCAG21/#language-of-page
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/TR/WCAG21/#meaningful-sequence


If content requires user input, labels or 
instructions are provided. This includes 
when the user selects an incorrect 
answer. 
WCAG 2.1 – 3.3.2

Instructions do not rely solely on sensory 
characteristics such as size, shape, 
location, orientation, or sound. 
WCAG 2.1 – 1.3.3

If content is limited by time, there is 
enough time for all users to read and use 
that content; alternatively there is a way 
to disable the time limit. 
WCAG 2.1 – 2.2.1

Notes and Locations of Issues Notes and Locations of Issues

Notes and Locations of Issues

Input Assistance Sensory Characteristics

Time

When using assistive technology, the 
content is perceived in an order that 
makes the interaction meaningful. 
WCAG 2.1 – 1.3.2 

When multimedia content changes, 
assistive technology (such as JAWS) is 
alerted to those changes. 
WCAG 2.1 – 4.3.1

Notes and Locations of Issues

Notes and Locations of Issues

Reading Order

Screen Reader

Section 7: Interactions
This section is not applicable

https://www.w3.org/TR/WCAG21/#labels-or-instructions
https://www.w3.org/TR/WCAG21/#sensory-characteristics
https://www.w3.org/TR/WCAG21/#timing-adjustable
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/TR/WCAG21/#status-messages


For audio files (such as podcasts or
recordings), a transcript of the audio is
in close proximity to the audio file. 
WCAG 2.1 – 1.2.1

All audio and video can started,
stopped, and paused by the user. 
WCAG 2.1 – 1.4.2

Video transcript should be available
and in close proximity to the video. 
WCAG 2.1 – 1.2.3

Video transcript is a “descriptive 
transcript.” It includes information 
that the user needs to know but is not 
explicitly described in the video. 
WCAG 2.1 – 1.2.3

Synchronized, closed captions are 
available. They appear on-screen at the 
same time as the sound and they can be 
turned on or off by the user. 
WCAG 2.1 – 1.2.5

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Audio

User Control

Video

Audio transcripts should identify the
speaker. 
WCAG 2.1 – 1.2.1

A dynamic table of contents must
include bookmark links that take the
user directly to the content. 
 
WCAG 2.1 – 2.1.1

Notes and Locations of Issues

Notes and Locations of Issues

Digital Publications

Section 8: Multimedia
This section is not applicable

https://www.w3.org/TR/WCAG21/#audio-only-and-video-only-prerecorded
https://www.w3.org/TR/WCAG21/#audio-control
https://www.w3.org/TR/WCAG21/#audio-description-or-media-alternative-prerecorded
https://www.w3.org/TR/WCAG21/#audio-description-or-media-alternative-prerecorded
https://www.w3.org/TR/WCAG21/#audio-description-prerecorded
https://www.w3.org/TR/WCAG21/#audio-only-and-video-only-prerecorded
https://www.w3.org/TR/WCAG21/#keyboard


The following Rise blocks are not 
currentlykeyboard accessible:  
• Image and quote carousels  
• Process interactions  
• Drag-and-drop interactions  
• Charts To use these, provide a text 
alternative located in close proximity. 
Articulate: Design Your Course with 
Accessibility in Mind

Provide instructions for use for all 
interactions. Some interactions do not 
have native instructions; they should be 
added by the developer:  
• Sorting  
• Carousels  
• Flashcards  
• Matching drag-and-drop 
WCAG 2.1 – 3.3.2

Select the course language in the course 
settings so that JAWS can correctly 
announce information such as interface 
elements and content. 
WCAG 2.1 – 3.1.1

All content should be able to be heard 
and seen. Rise lessons should include:  
• audio narration that is available just 
prior to the text being narrated. If the 
lesson is long, split the content into 
digestible chunks, each with its own 
narration block.  
• closed captions on each video (can be 
turned on/off by the user)  
• A transcript of all course content 
available to the user in a convenient way. 
It should include descriptions of video 
content that is heard but not seen (such 
as knocking at a door) or seen but not 
heard (such as a mouse moving to and 
clicking a box in ARD). 
WCAG 2.1 – 1.1.1

Video transcripts should include 
descriptions of video content that is • 
heard but not seen (such as knocking at 
a door), or • seen but not heard (such as 
a mouse moving to and clicking a box in 
ARD). 
WCAG 2.1 -1.2.5

Audio clips should include a transcript if 
the text is not already included in a Rise 
block. 
 
WCAG 2.1 – 1.1.1

Each image that is essential to learning 
has meaningful alternative text. 
WCAG 2.1 – 1.1.1

Provide a text-based alternative to all 
interactions in the transcript. It should 
include the content the learner needs to 
know or learn from the interaction. 
WCAG 2.1 – 1.1.1

Do not use images of text unless the 
content is also available in text format 
(in the image caption, alt text, or nearby 
text) 
Articulate: Design Your Course with 
Accessibility in Mind

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Alternative Text

Interactions

Language

Multiple Sensory Inputs

NOTE: There are two pages for the 
Articulate Rise section. Select the tabs 
to navigate each page. 

Section 9: Articulate Rise
This section is not applicable

https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://www.w3.org/TR/WCAG21/#labels-or-instructions
https://www.w3.org/TR/WCAG21/#language-of-page
https://www.w3.org/TR/WCAG21/#non-text-content
https://www.w3.org/TR/WCAG21/#audio-description-prerecorded
https://www.w3.org/TR/WCAG21/#non-text-content
https://www.w3.org/TR/WCAG21/#non-text-content
https://www.w3.org/TR/WCAG21/#non-text-content
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course


Each element should meet minimum 
color contrast standards, in all states. 
Articulate: Design Your Course with 
Accessibility in Mind

Lesson transcripts should include a 
dynamic table of contents that allows 
users to skip easily to any lesson.  
WCAG 2.1 – 2.4.1

The style of a button should match its 
expected functionality.  
WCAG 2.1 – 3.2.3 
WIP LD&D Curriculum Deliverable 
Standards 

Use section headers whenever possible 
to aid in understanding.  
Articulate: Design Your Course with 
Accessibility in Mind

The text on a button should match its 
expected functionality. 
 
WIP LD&D Curriculum Deliverable 
Standards  
WCAG 2.1 – 3.2.4

Provide accessibility instructions in the 
beginning of the course to inform users 
of the layout and design before they 
start. This can be located in the first 
lesson of the course, which can easily be 
skipped by users who do not require it.  
Articulate: Design Your Course with 
Accessibility in Mind

Provide Rise keyboard shortcuts via this 
link:  
https://articulate.com/support/article/
RiseKeyboard-Accessible-Navigation Use objects, formatting, and spacing 

consistently. 
Articulate: Design Your Course with 
Accessibility in Mind 
WIP LD&D Curriculum Deliverable 
Standards

When creating buttons that are unusual, 
include guidance on how to use the 
button.

Use the feedback functions for all answer 
choices so that learners can monitor 
their understanding. Ensure that there 
is a “Close” button on all feedback that 
can be accessed and triggered by a 
keystroke.  
Articulate: Design Your Course with 
Accessibility in Mind

Audio and video blocks should have 
a caption or some other indicator that 
describes the purpose of the media. 
Articulate: Design Your Course with 
Accessibility in Mind

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues Notes and Locations of Issues

Notes and Locations of Issues Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Color Contrast

Transcript

Navigability Universal Design for Learning

2
Page

NOTE: There are two pages for the 
Articulate Rise section. Select the tabs 
to navigate each page. 

Section 9: Articulate Rise
This section is not applicable

https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://www.w3.org/TR/WCAG21/#bypass-blocks
https://www.w3.org/TR/WCAG21/#consistent-navigation
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://www.w3.org/TR/WCAG21/#consistent-identification
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-Keyboard-Accessible-Navigation
https://access.articulate.com/support/article/Rise-Keyboard-Accessible-Navigation
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course


Each image that is essential to learning 
has meaningful alternative text. 
WCAG 2.1 – 1.1.1

Focus order has been checked on each 
slide for order and alt text of objects. 
WCAG 2.1 – 1.3.2  
WCAG 2.1 -2.4.3

Provide a text-based alternative to all 
interactions in the form of a transcript. 
It should include the content the 
learner needs to know or learn from 
the interaction. Place transcript in the 
Resources section of the player, labeled 
“Transcript.” 
WCAG 2.1 – 1.1.1

Slide text is also presented through 
narration. (Human narration is the first 
choice; computer narration is the second 
choice.) 
WCAG 2.1 – 1.1.1

All content should be able to be heard 
and seen. Slides should include:  
• audio narration on each slide.  
• closed captions of narration (can be 
turned on/off by the user.)  
• A transcript of all course content 
available to the user in a convenient way 
so that if at any time the user cannot 
perceive necessary content as presented, 
they can access the transcript and gain 
the same information.  
• If appropriate for the interaction, 
include a transcript of it in the Storyline 
player as an additional tab. 
WCAG 2.1 – 1.1.1

Each image that is decorative/
nonessential has a null alt tag that is 
two quotation marks without a space in 
between, i.e. “” so that Jaws will ignore it. 
WCAG 2.1 – 1.1.1

All unnecessary focus order items have 
been removed from the focus order 
list. No “phantom focus indicators” are 
presented to the Jaws user. 
WCAG 2.1 – 1.3.2  
WCAG 2.1 -2.4.3

Slide narration is placed first in the focus 
order. 
WCAG 2.1 – 1.3.2  
WCAG 2.1 -2.4.3

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Alt Text

Focus Order

Interactions

Narration

Multiple Sensory Inputs

NOTE: There are two pages for the 
Articulate Storyline section. Select 
the tabs to navigate each page. 

Section 10: Articulate Storyline
This section is not applicable

https://www.w3.org/TR/WCAG21/#non-text-content
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/TR/WCAG21/#focus-order
https://www.w3.org/TR/WCAG21/#non-text-content
https://www.w3.org/TR/WCAG21/#non-text-content
https://www.w3.org/TR/WCAG21/#non-text-content
https://www.w3.org/TR/WCAG21/#non-text-content
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/TR/WCAG21/#focus-order
https://www.w3.org/TR/WCAG21/#meaningful-sequence
https://www.w3.org/TR/WCAG21/#focus-order


Provide accessibility instructions in the 
beginning of the course to inform users 
of the layout and usage before they start. 
This can be included on one of the first 
slides and can be easily skipped by those 
who do not require it. 
 
Articulate: Design Your Course with 
Accessibility in Mind  
WCAG 2.1 – 3.3.2

Each slide and scene are named 
appropriately so that the Storyline player 
can display them in the sidebar menu so 
the Jaws user can identify slide content 
without actually reading each slide. 
WCAG 2.1 – 2.4.1

In Storyline player controls: volume, 
captions, seek bar, play/pause, and 
accessibility controls are selected. 
WCAG 2.1 – 2.2.2

Notes and Locations of Issues

Notes and Locations of Issues

Notes and Locations of Issues

Universal Design for Learning

Navigation

2
Page

NOTE: There are two pages for the 
Articulate Storyline section. Select 
the tabs to navigate each page. 

Section 10: Articulate Storyline
This section is not applicable

https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://access.articulate.com/support/article/Rise-360-How-to-Design-an-Accessible-Course
https://www.w3.org/TR/WCAG21/#labels-or-instructions
https://www.w3.org/TR/WCAG21/#bypass-blocks
https://www.w3.org/TR/WCAG21/#pause-stop-hide
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